
SKI Report 2004:20

Research

Computer Programs for Uncertainty
Analysis of Solubility Calculations:
Windows Version and Other Updates
of the SENVAR and UNCCON
Program Description and Handling Instructions

Christian Ekberg
Arvid Ödegaard-Jensen

April 2004

ISSN 1104–1374
ISRN SKI-R-04/20-SE



SKI perspective 
 
Background 
 
Solubility calculations for phases incorporating radionuclides are an essential element of 
estimating releases from the near-field of a final repository for spent nuclear fuel. 
Implementation of solubility estimates in safety assessment requires an evaluation of 
uncertainties associated with this category of input data. Particularly important uncertainties 
in the context of radionuclide solubility can be related to the choice of thermodynamic data 
for dissolved species and solid phases, as well as the composition of a groundwater in which a 
particular solid phase might precipitate. The evaluation of such uncertainties is simplified if 
computer programmes dedicated for this task are available. The SENVAR and UNCCON 
solubility and speciation programmes have been developed solely for uncertainty and 
sensitivity analysis. 
 
Purpose of Project 
 
The purpose of this project was to develop user friendly Windows-based versions of the 
previously developed SENVAR and UNCCON computer programmes. This should promote 
the spreading of the codes to potentially interested new users. 
 
Results 
 
The new code versions, SENVARWIN and UNCCONWIN, can be downloaded from the 
following  link: www.nc.chalmers.se/software/program.htm  Alternatively, the codes 
can be obtained directly from the author, Dr. Christian Ekberg at Chalmers University of 
Technology (email adess: che@chem.chalmers.se).  
 
This report describes how the codes can be used for a case with a plutonium solubility 
calculation.  
 
Effects on SKI work 
 
The codes may be useful for SKI in a future evaluation of solubility calculations conducted by 
the Swedish Nuclear Fuel and Waste Management Company (SKB).  
 
Project Information 
 
Bo Strömberg has been responsible for this project. 
SKI reference: 14.9-030165/03101 



SKI Report 2004:20

Research

Computer Programs for Uncertainty
Analysis of Solubility Calculations:
Windows Version and Other Updates
of the SENVAR and UNCCON
Program Description and Handling Instructions

Christian Edberg
Arvid Ödegaard-Jensen

Department of Nuclear Chemistry
Chalmers University of Technology
SE-412 96 Göteborg
Sweden

April 2004

SKI Project Number XXXXX

This  report  concerns  a  study  which has
been  conducted  for the Swedish Nuclear
Power  Inspectorate  (SKI). The conclusions
and viewpoints presented in the report are
those of  the  author/authors  and  do not
necessarily coincide with those of  the SKI.



 

Table of contents 
 
1. Introduction ...........................................................................................1 
 
2. SENVARWIN ........................................................................................2 
 
 2.1 Program description ....................................................................2 
 2.2 Handling instructions and test case............................................4 
 
3. UNCCONWIN .....................................................................................10 
 
 3.1 Handling instructions and test case..........................................10 
 
4. Conclusions ..........................................................................................16 
 
5. Acknowlegement..................................................................................17 
 
6. References ............................................................................................18 
 
 
Appendix 1: SENVARWIN example project file ....................................20 
 



1 

1. Introduction 
 
Since the construction of the first computer, simulations have become a more or less 
indispensable tool in research and industry. With increasing speed and cheaper 
computer time, computer simulations have become the major contributions to the art of 
foreseeing the future. However, most computer programs are deterministic, i.e. the same 
set of input data will give the same set of output data, and it is therefore essential for the 
correctness of the results that the input data are correct. Unfortunately, it is seldom 
possible to obtain correct data and, hence, the results from computer simulations are 
more or less uncertain. 
  
An investigation is usually partitioned into a sensitivity analysis and an uncertainty 
analysis. In most cases, these two analyses complement each other well and are 
therefore often performed simultaneously. The sensitivity analysis indicates the relative 
importance of each input parameter, and the uncertainty analysis gives estimations of 
the fluctuations in the calculated results from uncertainties in the input data. Several 
methods exist to treat the uncertainties associated with computer simulations, either by 
sampling techniques or experimental designs (Helton, 1993; Iman and Helton, 1985; 
Kleijnen, 1997). 
  
In studying the potential construction of an underground repository for spent nuclear 
fuel according to the multi barrier concept (KBS-3, 1983; PASS, 1993), investigations 
and predictions, e.g. rates of canister corrosion and radionuclide transport, have to be 
made with computer programs. In these calculations, the input data are usually not 
accurately determined but more often only estimated from incomplete experimental 
results or theoretical correlations. This results in uncertainties, which varies 
tremendously in magnitude and importance. For near-field radionuclide transport 
calculations, one important factor is the solubility of the radioelements released from 
the fuel within a breached canister. The solubilities can be measured as well as 
calculated from fundamental thermodynamic data. If they are calculated, several input 
data, such as stability constants, enthalpies of reaction and water composition, will 
affect the results. The influence of the thermodynamic data uncertainties are 
investigated in (Ekberg et al., 1995; Ekberg and Lundén, 1997) using the SENVAR 
program (Ekberg 1996:1; Ekberg and Emrén1996), and the water composition influence 
is discussed in, e.g. (Ekberg et al. 2000).  
 
The variation in water composition owing to uncertainties in rock composition which is 
a separate but complementary issue has also been investigated and reported in, e.g. 
(Ekberg et al. 2000). Due to the increasing demand for these old programs they have 
now been rewritten to be fully Windows compatible. The user interface is now like what 
every ordinary computer user is accustomed to with easy-to-use menus. The names of 
the programs have been changed accordingly to easily differentiate from the older 
programs by adding a “WIN” at the end of the program name, e.g. SENVARWIN. In 
addition to the change in the user interface the calculation motor has been changed from 
the older FORTRAN PHREEQE (Parkhurst et al. 1980) to the newer PHREEQC 
(Parkhurst 1995) written in C. This change has enhanced the stability of the programs. 
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2. SENVARWIN 
 
The older SENVAR program has been extensively described in (Ekberg 1995, Ekberg 
1996, Ekberg and Emrén 1996). However, for the conveniency of the reader a short 
summary of this information is given below. In addition, the description given below 
refers to the new version called SENVARWIN. 
 
2.1 Program description 
 
The SENVARWIN package is a combined statistical sampling and evaluation program. 
The solubilities are calculated by the thermodynamic equilibrium program PHREEQC 
(Parkhurst 1995) . 
  
The calculation frame, which is given by the user, is constituted by choice of solid 
phase, water composition and database used. It is also necessary to give some iteration 
criteria. The calculations are then made in steps, first a preliminary sensitivity analysis 
and then an uncertainty analysis, the results of which are also used for the stepwise 
regression, which serves as the final sensitivity analysis. 
 
2.1.2 Sensitivity analysis (screening) 
 
The preliminary sensitivity analysis aims at reducing the number of parameters to be 
entered into the uncertainty analysis and the final sensitivity analysis. It may be 
performed in two ways, either by using a variance analysis or by a binary search tree. 
The main advantage of the variance analysis is that a preliminary ranking of the 
parameters is made, but the calculations take a great deal of time. The binary search 
tree, on the other hand, is fast but does not rank the parameters. The concepts of the two 
approaches are explained below. 
 
2.1.2.1 Variance analysis 
 
The variance analysis is made by holding one of the investigated parameters at a fixed 
value while the others vary for a given number of iterations, e.g. 20. The variance in 
solubility for these iterations is then calculated, and the next parameter of interest is 
held at a fixed value. The species that gives the smallest variance when held constant is 
deemed the most important and so on. 
  
At the beginning of the calculations, a random matrix is created. It contains random 
values for the different parameters, each sampled within a given uncertainty range. 
  
There is one row for each investigated parameter. These rows combined forms a matrix 
with as many rows as there are investigated parameters and as many columns as the 
selected iteration number. In the first iteration, the first parameter is held at a fixed 
value and the others receive values according to the first column of the matrix. In the 
next iteration, the values are taken from the second column and so on for the given 
number of iterations. The second parameter is then held at a fixed value and the others 
receive values according to the columns of the random matrix. Evidently this approach 
will give the same variance for the unimportant parameters, thus making the selection 
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criterion simple. The selection criterion is usually that the difference between two 
successive variances must be at least one thousandth of the last one. The important 
parameters are then transferred to the uncertainty analysis. 
 
2.1.2.2 Binary search tree 
 
The theory behind the binary search tree is rather simple, and the approach is more 
commonly used in optimisation problems. The inputs to the model are seen as a vector 
containing the different parameter values. It is known, a priori, that only a few of these 
are important. Therefore, by using a binary search tree, the number of iterations needed 
to identify the important parameters may be less than the total number of parameters. 

  

 
Figure 1, Binary search tree for a 28-cell input vector 

 with three important parameters (filled boxes). 
 
The method illustrated in Figure 1 may be described in the following way. The 
calculations are made two times, one with every investigated parameter at their 
maximum value, and one with the minimum value. The results are then compared to 
investigate whether or not there is a significant difference. If so, the input vector is 
divided into two parts, each becoming the base for further calculations. The same 
approach is used at the next level of the search tree, except that at this level it is the 
values in half of the original vector that are changed while the rest are held fixed. If 
there is no significant change this time, it is concluded that there are no important 
parameters in that part of the vector and it is not further investigated. If the change is 
significant, the new vector is divided into two parts and the method described above is 
applied to both parts.  
 
Finally, all the important parameters are identified. Synergistic or antagonistic (positive 
or negative correlation) effects will not be explicitly detected in this version, however 
this might be added at a later stage. Consider the case in which two iterations are made 
at each level, i.e. high and low values for the parameters. The range of values should be 
selected to mirror the real uncertainty range. This implies that the sensitivity analysis is 
only valid given an uncertainty range of parameters, which is the normal way it is done. 
The number of iterations needed to investigate which parameters influence the result 
may then be significantly reduced if the method indicated in Figure 1 is used.  
 
As seen for the case described above, the number of iterations was only slightly reduced 
compared with the "one factor at a time" approach. However, as the number of 
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parameters grows, the greater the profit will be of using a binary search tree. For the 
cases described in this section, the number of parameters is usually about two hundred 
and there are between one and six important ones. Thus the approach is very effective in 
the sense that it requires only a few iterations, usually reduced to about a third of the 
number of parameters. 
 
2.1.3 Uncertainty analysis 
 
In the uncertainty analysis, the Monte Carlo sampling is made without any restrictions, 
i.e. the values of the parameters are selected randomly within each interval at each 
iteration. This approach makes it possible to detect any synergistic effects between two 
or more species. The calculations are usually made with 1000 to 2000 samples, thus 
giving enough values to cover the parameters' space sufficiently well. Every solubility 
calculation is saved in a file which is later used for the final sensitivity analysis. 
 
The results of the uncertainty calculations are a plot showing the calculated density 
function of the solubilities and some statistics. The calculated statistics are the mean, 
the variance, the skewness, a 95% confidence interval for the mean based on  the 
solubilities being log-normally distributed and a 95% confidence interval for the 
solubility population based on an arbitrary distribution, see Appendix in (Ekberg and 
Emrén 1996). These data may then be used as input to, for example, a transport model. 
  
The final sensitivity analysis is made from the solubility calculations in the uncertainty 
analysis, thus requiring no further PHREEQC runs. The program that performs these 
calculations is the STEPR program (Liljenzin 1995). It is assumed that the sensitivity to 
one parameter is described by the regression coefficients, a

 0  through an, in a linear 
model, such as: 
 
Y=a0+a1x1+.........anxn       (1) 
 
where x1 through xn represent the input parameters, e.g. the logarithm of the stability 
constants or the enthalpies of reaction, and Y represents the output result, i.e. 
solubilities. Such an approach yields very small regression errors in the cases used here 
and may therefore be usable. 
 
2.2 Handling instructions and test case 
 
The user interface of SENVARWIN is made in the Borland C++ builder and thus 
comprise compatibility with the common Microsoft Windows format. In addition the 
menus look and work like most other modern applications. In this section we will make 
a project based on an solubility investigation of the solid phase Pu(OH)4. We do not 
state that this phase is necessarily the solubility limiting one in this water, but is only 
selected as an example. The use of the program, when investigating the effect of 
uncertainties in enthalpies of reaction, are made in a similar way as the stability 
constants and will not be further dealt with here. Another reason for excluding these 
calculations is the lack of reliable data on enthalpies of reaction. The water used here 
will be the one selected as a reference water for the Äspö site in Sweden, see Table 1. 
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Table 1, Composition of reference water from the Äspö site, borehole KAS 02, level 530-535m (Smellie 
et al. 1992, Nilson 1992). Concentrations in mM. 

 
Ca 47.2  Cl 181  Ua 5.45E-07 
Mg 1.73  Ctot 0.164  Sr 0.399 
Na 91.3  Stot 5.83  Li 0.144 
K 0.207  F 7.90E-02  Ntot 3.52E-03 

Fea 4.37E-03  Br 0.501  pH 8.1 
Mn 5.28E-03  P 1.61E-04  peb -4.37 
Ala 1.00E-03  Si 0.146  

Temp (°C) 15 
a The analysis did not contain any value for this species. The concentration was estimated on the basis of 

other Äspö ground water samples (Emrén 1995). 
b The pe value was adjusted from the measured value  (-5.42) with regard to additions of Al, Fe, U, and 

the equilibrium between SO42-/SO32- in the solution (Emrén 1995). 
 
We will in this case use the uncertainties given as default by SENVARWIN, i.e. the 
uncertainty in the logarithm of the stability constants are two units wide for the 
screening and one unit wide for the uncertainty analysis. These values are default and 
may be changed in the program. However, for the screening it is reasonable to keep 
these values while in the uncertainty analysis real values may be entered if they may be 
obtained. These latter values will also be used in the final sensitivity analysis 
The main screen comprises all the necessary information for an analysis. The layout is 
shown in Figure 2. 
 

 
Figure 2, The main window of the SENVARWIN program. 
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In this screen the project is managed and the user may choose project and database. In 
the “Edit” menu it is possible to select which water to use and also the project 
parameters are given, see Figure 3. These project parameters may either be changed 
here or a complete set of project parameters may be imported from another project by 
using the “Import project parameters” option in the “File” menu. 
 

 
Figure 3 The project parameters window 

 
 
It is worth noting that in this screen, c.f. Figure 3, the user also gives some information 
related to how the following sensitivity and uncertainty analysis should be made, e.g. 
the number of iterations per species in the variance analysis and total number of 
iterations in the uncertainty analysis. This last number of iterations is also the number 
used for the stepwise regression used in the final sensitivity analysis. It is possible to 
select whether the pH, pe and temperature should also be treated as uncertain 
parameters. This option is available for the variance and the uncertainty analysis, but 
not for the binary search tree. The solid phase selected must be present in the selected 
database and printed in the same way in this window. If not the name will become red 
and thus indicating that it has to be changed before a calculation can be made. 
 
For this test case the concentration of each element is already the correct one, but if this 
is not the case it can easily be changed by left clicking in the element name column, se 
Figure 4. If a completely different water composition is to be used just use the “File” 
menu and select import water. There it is possible to import a complete water 
composition from another project. 
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Figure 4, The water window 

 
All the choices made in the paragraphs above are saved in the project file named 
“example.prj”, see Appendix 1. Having this information, the ground is set for starting a 
new simulation by selecting whether to make the preliminary sensitivity analysis 
(screening) by using the variance analysis or the binary search tree approach. The 
variance analysis, as explained above, is slower but gives a more specific result than the 
binary search tree. In the case presented here we will run both simulation types starting 
with the variance analysis. It is started by using the menus “simulation” and select 
“variance analysis”. 
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Table 2, Results from the variance analysis 
 

Species variance 
Solid_phase 9.00E-08 

pH 1.35E-07 
Pu(CO3)3

2- 4.23E-07 
Pu3+ 5.84E-07 
OH- 6.44E-07 
temp 6.47E-07 

PuCO3
+ 6.55E-07 

CaOH+ 6.55E-07 
NaCO3- 6.59E-07 

Pu(OH)2
+ 6.60E-07 

 
The result displayed in Table 2 is an excerpt from the file “example.spc”, which is 
found in the “Project” folder in the SENVARWIN directory. 
To make this example as thorough as possible we will also run the binary search tree 
which is made in a similar manner as the variance analysis. The results are shown in 
Table 3 and found in the file “Example.bst”. 
 

Table 3, Results from the binary seach tree analysis 
 

Species 
NaCO3

- 
NaHCO3 
PuCl2+ 

Pu(CO3)3
2- 

Pu(CO3)4
4- 

Pu3+ 
 
It can be interesting to compare the results from the variance analysis with the binary 
search tree. Often the species suggested by the binary search tree will be found among 
the ones selected by the variance analysis. If they should display completely different 
sets there are large synergistic or antagonistic effects present. In any case the results 
from the above mentioned analyses should be compared with the results from the final 
sensitivity analysis shown in Table 4 below. 
  
When the sensitivity analysis is made it is possible to simultaneously perform a 
uncertainty analysis. This is made by selecting “uncertainty analysis” from the 
“Simulation” menus. 
 
The results from the uncertainty analysis may be displayed by selecting the “display” 
menus. In this window the user must select the number of iterations to display. This 
should, naturally, be less than or equal to the number of runs in the uncertainty analysis. 
Then the number of intervals should be selected. It may give the user a basis for 
selecting an empirical distribution function, e.g. by changing the input values and 
observe the changes in the appearance of the picture to the right in Figure 5. 
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 Figure 5, The SENVARWIN  display window 
 
In the left side of the Display window, some statistical estimators are shown, i.e. mean 
solubility, standard deviation, minimum solubility, maximum solubility, skiewness and 
some confidence intervals namely those representing the confidence interval for the 
mean and the population, respectively. It is also possible to save the displayed plot data 
by clicking on that button. The “x” and “y” values will be saved in a file specified by 
the user.  
 
The final sensitivity analysis is made by stepwise regression of the logarithm of the 
solubility versus the logarithm of the stability constants. The results from this test case 
is shown in Table 4. They are found in the file “Example.res”. 
 

Table 4, The results from the stepwise regression 
 

Species Regression coefficient 
pH -1.60 

Solid 0.99 
Pu(CO3)3

2- 0.75 
pe 0.16 

Pu3+ 0.15 
OH- 0.019 

 
Clearly the results from the variance analysis and the stepwise regression are very 
similar. This gives confidence in that the adopted linear model is valid. In addition there 
seems to be few correlations of importance which can be expected when only one 
species of each type is dominating, e.g. only Pu(CO3)32- the for the plutonium 
carbonates. 
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3. UNCCONWIN 
 
The UNCCON program investigates how uncertainties in water composition affect the 
solubility of a solid phase. Each element concentration is given as a uniformly 
distributed interval, indicated by the user, from which the samples are taken using 
simple Monte Carlo sampling. Other factors that can be selected are different iteration 
criteria, e.g. number of LHS intervals, and which database to use. The preliminary 
sensitivity analysis is made in a similar way to the SENVARWIN program, i.e. the user 
may select either a variance analysis approach or a binary search tree. However, in 
contrast to the SENVARWIN program the number of uncertain variables here is rather 
small. Thus, if the number of elements in the water is smaller than 19 there is no need 
for the screening by the preliminary sensitivity analysis. These approaches implicitly 
takes correlations into account, which may, when compared to the final sensitivity 
analysis, give an answer whether the correlations are important or not. The final 
sensitivity analysis is made based on the runs of the uncertainty analysis. This 
sensitivity analysis uses simple linear regression and thus only first order interactions 
are detected. If there is a distinct difference between the results of the first sensitivity 
analysis and the linear regression it may be due to that higher order interactions, e.g. 
correlations, play an important role. 
 
The result of an UNCCONWIN uncertainty calculation consists of two parts: first, a file 
containing some statistical estimators such as the mean solubility, minimum and 
maximum solubility and a confidence interval for the mean and, secondly, a part 
consisting of plots of the calculated distribution function for the solubility. Depending 
on the sample size the plots may be somewhat jagged, but they will at least give a hint 
of the distribution of the solubility. 
 
3.1 Handling instructions and test case 
 
The handling of the UNCCONWIN is very similar to that of SENVARWIN with a 
specific purpose. In the future these programs will, together with a rewritten version of 
the MINVAR (Ekberg et al. 2000) and the LJUNGSKILE (Ekberg et al. 2003) program, 
be combined into one large computer package for uncertainty analysis of chemical 
calculations. 
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When the program is started the main window is displayed, see Figure 6.  
 

 
Figure 6, The main window of the UNCCONWIN program 

 
The calculations starts by the user selecting a project from the list. There should always 
be at least one project in that list. The default is the “example” project. Then a database 
is selected. In the “Edit” menu the water and the project parameters are then edited, see 
Figure 6 and 7. The water used in this case is the same as for the SENVARWIN 
calculations presented earlier in this report. The uncertainties in the concentrations are 
from Nilsson (1992) and Samuelsson (1996). 
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Figure 7, The water composition window. 

 
In the “water composition window” the user need to specify the water chemistry 
parameters. In addition, a choice is needed whether or not a constant percentage 
uncertainty should be used. Generally, it may be difficult to obtain specific values for 
the different uncertainties and in such a case it might be a good idea to select this 
option. However, if uncertainty data exist or may be estimated with reasonable accuracy 
it is better to utilise them, as is done in this test case. The user has then to give the 
minimum and maximum value for the different element concentrations and also state 
whether the sampling should be made within a linear or logarithmic interval. Generally, 
a linear interval is enough but if some element has an uncertainty interval ranging over 
several orders of magnitude (in this case see the Al interval) this fact is better reflected 
with a logarithmic interval. The sampling is the made from a uniform distribution in 
order not to underestimate the effect of the uncertainties since in this case there are no 
tails in the distribution. 
 
When the water parameters are selected the different parameters for the calculations 
need to be set. This is done by selecting the “Project parameters” option in the “Edit” 
menu, see Figure 8. 
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Figure 8, The Project parameter window 

 
In this window the user selects which element to monitor and which solid phase to 
equilibrate with. The element name and the solid phase is case sensitive so if they 
appear red, i.e. not in the database, this could be due to just a mistyping of the cases. 
The statistical parameters “seed to randomiser” and “iterations per element” is also 
selected here. As for SENVARWIN the seed may be selected arbitrarily but the number 
of iterations per element for the variance analysis should be at least 20. Contrary to the 
SENVARWIN program the user does not give the number of iterations here. In 
UNCCONWIN this number is set to 900. 
 
If changes were made to either the water or the project parameters it is probably a good 
idea to save this new project as a new project. This is done by using the “Save as” 
option in the “File” menu. 
 
For tutorial purposes we will now run both the variance analysis and the binary search 
tree as preliminary sensitivity analyses. However, preliminary sensitivity analysis is not 
a prerequisite in UNCCON since the number of uncertain input variables is relatively 
small. Thus, if the number of elements in the water is less than 19 it is just as easy to 
run the uncertainty analysis from the beginning. However, if the number of elements  is 
greater than 19 it is recommended to run a screening. The binary search tree is run by 
selecting it from the sensitivity analysis menu. The results from the binary search tree 
may be found in the “example.bst” file. However, as will be seen later, investigation of 
this file is not necessary. The variance analysis is selected in a similar way and the 
results may be found in “example.spc”. 
 
When the screening sensitivity analysis is done the uncertainty analysis is started by 
selecting it from the menu. The uncertainty analysis window will then appear, see 
Figure 9. 
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Figure 9, Uncertainty analysis window 

 
The main function of the “Uncertainty analysis window” is to determine which 
elements should be included in the uncertainty analysis. The number for this analysis is 
limited to 19. However, this is not a big limitation since often the number of elements in 
a given water analysis is usually smaller than 19. If this is not the case, UNCCONWIN 
can make a preliminary sensitivity analysis to rank the elements with respect to their 
importance, as described earlier. The user may select the order of the elements in the 
uncertainty analysis and may also move them around arbitrarily by right clicking on the 
particular element that should be moved. The important thing is to remember that only 
the 19 first elements will be used in the uncertainty analysis. It is also possible to 
include fewer elements in the uncertainty analysis by adjusting the number at the top of 
the window. 
 
The uncertainty analysis is started by clicking on this button, c.f. Figure 9. When the 
uncertainty analysis is ready the results may be displayed by selecting this option from 
the menus of the main window, see Figure 10. 
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Figure 10, The Display window 

 
In the Display window all relevant information from the uncertainty analysis and the 
final sensitivity analysis may be found. At the top the user may select the number of 
iterations that should be used for the plot of the distribution function and also how many 
intervals to use. There is also a possibility to select different axes such as linear or 
logarithmic. Then the statistical data such as mean, standard deviation, skiewness and 
some confidence intervals are given. These are explained in more detail in Ekberg and 
Emrén (1996). Proceeding to the right, the results from the final sensitivity analysis are 
shown together with their regression coefficient. The greater the absolute value of this 
coefficient, the more important the element is for the solubility of the solid phase in this 
water and with the uncertainty ranges given. In this case inorganic carbon is, by far, the 
most important element and this is due to strong plutonium carbonate complexation in 
the water used. The plot data may also be saved in a separate file for use by another 
plotting program and this is done by clicking on the “Save plot data” button.  
For interpretation of these kinds of calculations we refer to the relevant papers in the 
reference list. 
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4. Conclusions 
 
Uncertainty and sensitivity analysis is becoming more and more important for testing 
the reliability of computer predictions. Solubility estimations play important roles for, 
e.g. underground repositories for nuclear waste, other hazardous materials as well as 
simple dissolution problems in general or industrial chemistry applications. The 
calculated solubility of a solid phase is dependent on several input data, e.g. the stability 
constants for the complexes formed in the solution, the enthalpies of reaction for the 
formation of these complexes and also the content of other elements in the water used 
for the dissolution. These input data are determined with more or less accuracy and thus 
the results of the calculations are uncertain. For the purpose of investigating the effects 
of these uncertainties several computer programs were developed in the 1990:ies, e.g. 
SENVAR, MINVAR and UNCCON. Of these SENVAR and UNCCON now exist as 
windows programs based on a newer speciation code. In this report we have given an 
explanation of how the codes work and also given some test cases as handling 
instructions. The results are naturally similar to the previous ones but the advantages are 
easier handling and more stable solubility calculations. With these improvements the 
programs presented here will be more publically accessible. 
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Appendix 1: SENVARWIN example project file 
 
SENVARWIN project file version 
1.0 
Begin Project 
Species of interest 
Pu 
NAME OF RESULTFILE 
PuOH4ret.dat 
pH,pe and temp included (y/n) 
Y 
Iterations per species 
20 
Seed to randomizer 
12 
Number of iterations 
1000 
Solid phase 
Pu(OH)4S 
End Project 
Begin Water 
Aespoe reference water 530-535 m sample 1432,ch.b with Na  
pH 
8.1 
pE 
-4.37 
Temperature ( deg. C ) 
19 
No. elements 
18 
Elements ( 'name' 'concentration' ) 
Ca  0.0472 
Mg  0.00173 
Na  0.094393 
K   0.000207 
Mn  5.28E-6 
Si  0.000146 
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Cl  0.181 
C   0.000164 
S   0.00583 
F   7.9E-5 
Br  0.000501 
P   1.61E-7 
Sr  0.000399 
Li  0.000144 
N   1.85E-6 
Al  1E-6 
U   5.45E-10 
Fe  4.37E-6 
End Water 
 




